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ABSTRACT 

 

 

 

During the operation of induction motor, stator resistance changes incessantly 

with the temperature of the working machine. This situation may cause an error in 

rotor resistance estimation of the same magnitude and will produce an error between 

the actual and estimated motor torque which can leads to motor breakdown in worst 

cases. Therefore, this project will propose an approach to estimate stator resistance of 

induction motor using fuzzy logic. Then, a correction will be making to ensure the 

stabilization of the system. 

 

 

Generally, this project can be divided into three parts which are design the 

induction motor by using the mathematical equation, design Fuzzy Logic estimator 

to estimate the value of stator resistance R S , and make the correction of stator 

resistance, R S . The MATLAB simulink is used in order to design the induction 

motor. Secondly, Fuzzy Logic Toolbox is used to design fuzzy logic estimator and 

finally the correction of R S  is make. 
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ABSTRAK 

 

 

 

Semasa operasi motor induksi, perubahan rintangan stator berkadar terus 

dengan suhu. Situasi ini boleh menyebabkan gangguan bagi menganggar jarak dan 

arah bagi rotor dan akan menghasilkan kesilapan antara kekuatan motor sebenar yang 

boleh menyebabkan kerosakan motor dalam keadaan amat teruk. Oleh itu, projek ini 

akan mencadangkan suatu pendekatan untuk meramal ketahanan stator motor induksi 

menggunakan Logic Fuzzy. Kemudian, pembetulan akan dilakukan untuk 

memastikan kestabilan sistem. 

Umumnya, projek ini boleh dibahagikan kepada tiga bahagian iaitu 

merekabentuk motor induksi dengan menggunakan persamaan, mencipta anggaran 

Logik Fuzzy untuk menganggarkan nilai rintangan stator Rs, dan membuat 

pembetulan bagi stator, Rs. Perisian MATLAB digunakan untuk merekacipta motor 

induksi. Kedua, Fuzzy Logic Toolbox digunakan untuk mereka anggaran logik fuzzy 

dan akhirnya pembetulan Rs dibuat. 
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CHAPTER 1 

 

 

INTRODUCTION 

 

 

 

1.1 Background 

 

Asynchronous motors, particularly the squirrel-cage induction motor, enjoy 

several inherent advantages like simplicity, reliability, low cost and virtually 

maintenance-free electrical drives. These facts are due to the induction motor 

advantages over the rest of motors. The main advantage is that induction motors do 

not require an electrical connection between stationary and brushes. Induction motor 

also has low weight and inertia, high efficiency and high overload capability.   

 

However, for high dynamic performance industrial applications, their control 

remains a challenging problem because they exhibit significant non-linearity and 

many of the parameters, mainly the stator resistance, vary with the operating 

conditions such as the temperature.  

 

The problem is overcome by adding another on-line estimation for R s  to the 

system using a fuzzy non-linear observer, giving the indirect vector control system, 

total immunity to resistance variations. The stator resistance identifier uses the error 

between a discrete estimate of stator current and the measured stator current, to map 

the change in stator resistance, using a fuzzy non-linear mapping.  
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The proposed fuzzy logic estimator, which is designed to estimate the change 

in stator resistance during the drive, is in operation. A fuzzy logic real time estimator 

is used as the stator resistance observer, to eliminate the error in rotor resistance 

estimation.  

 

Once the stator resistance is estimated, the new of stator resistance Rs is 

added to eliminate the error in rotor resistance and give same magnitude and same 

torque to the induction motor. 

 

 

1.2 Problem Statement 

 

A mismatch between the real rotor flux and the estimated rotor flux, leads to 

error between the real motor torque and the estimated torque and hence poor 

dynamic performance. The error in stator resistance R s , leads to errors in rotor 

resistance R r . 

 

 

1.3 Objectives of the project 

 

The vital objective of this project is to estimate stator resistance R s  in 

induction motor by using fuzzy logic estimator to eliminate an error of rotor 

resistance R r estimation in order to get the right magnitude and torque during the 

operation of induction motor.   

 

 

1.4 Scopes of the project 

 

The scopes of the project are: 

• Design an estimated of induction motor. 

• Design Fuzzy Logic estimator to estimate stator resistance R s . 

• Make the correction of stator resistance R s . 
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1.5 Thesis outline 

 

This thesis contains five chapters. Which are introduction, literature review, 

methodology, result and discussion, conclusion and recommendations. 

 

Chapter 1 is explaining about the background, objectives, and scopes of the 

project and overview of the whole chapter. This chapter explains more about the 

outcomes and introduction about this project. 

 

Chapter II provides a literature review on stator resistance overview in 

general. Other than that, this chapter also discusses about the methods used today to 

estimate stator resistances.  

 

Chapter III focuses on the methods that are used for this project including 

flow chart, and circuit design of the system. Other than that, it also discusses about 

software used for this project. The part of software can be divided into three parts 

which are designing estimated induction motor, design fuzzy logic estimator, and 

make the correction of stator resistance.  

 

Chapter IV discusses about the result obtained from the simulation. The 

results obtained are explained more detail part by part. The explanation includes 

equation, graph and theory of the whole project while Chapter V covers the 

conclusion, problems encountered and future recommendations about this project.   

. 

 



4 
 

CHAPTER II 

 

 

 

LITERATURE REVIEW 

 

 

 

 
2.1 Introduction 
  

 This chapter presents an overview of stator resistance R s  estimation of 

induction motor, and types of method that used for estimate the value of the stator 

resistance in induction motor. 

 

 

2.2 Stator Resistance Estimation Overview 

 

 The stator resistance changes due to the temperature variations and stator 

frequency variation that deteriorate the drive performance by introducing errors in 

the estimated magnitude and position of the stator flux vector. 

 

 

 

2.3 Types of Stator Resistance Estimation 

 

Direct torque control (DTC) of induction machines presents a good tracking 

for both electromagnetic torqueand stator flux [1]. This control scheme, shown in 

Figure 2.10, depends only on stator measurements. 
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Figure 2.1 Direct Torque Control (DTC) [1] 

 

Here [1] an artificial neural network (ANN) is used to accomplish tuning of 

the stator resistance of an induction motor. The parallel recursive prediction error and 

back propagation training algorithms were used in training the neural network for the 

simulation and experimental results, respectively. The neural network used to tune 

the stator resistance was trained on-line, making the DTC strategy more robust and 

accurate. Simulation results are presented for three different neural-network 

configurations showing the efficiency of the tuning process.[1] 

 

This paper [2] describes a Quassi-Fuzzy method of online stator resistance 

estimation of an induction motor, where the resistance value is derived from stator 

winding temperature estimation as a function of stator current and frequency through 

an approximate dynamic thermal model of the machine. The estimator has been 

designed and iterated by simulation study and then implemented by a digital signal 

processor on a 5 horse power stator flux oriented direct vector controlled drive. [2] 

 

In [3] presents application of Adaptive Neuro-fuzzy inference system 

(ANFIS) into a squirrel cage induction machine towards modeling, control and 
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estimation. This paper contributes (i) Development of a simple and more realistic 

model of the induction motor. Using ANFIS, the parameter sets of the motor model 

are estimated. The simplified model contains eleven estimated parameters. The 

identified model can be utilized for electric drives. (ii) Speed, torque and flux control 

using direct torque control (DTC) algorithm with ANFIS (iii) Design of Estimator 

through ANFIS which estimates the stator resistance with reference to the 

temperature when the DTC algorithm is involved. Better estimation of stator 

resistance results in the improvements in induction motor performance using DTC 

thereby facilitating torque ripple minimization. The values of stator voltage (V s ), 

stator current (I s ) and rotor angular velocity (ω r ) are taken. [3] 

 

 
Figure 2.2 Adaptive direct torque neuro fuzzy control [4] 

 

 

Figure 2.2 shows the block diagram of direct torque nuero fuzzy control 

(DTNFC) of induction motor. Torque and stator flux are estimated mathematically 

from the motor signals. Adaptive Neuro-fuzzy inference system (ANFIS) is used as 

controller to which the torque and flux errors along with position of stator flux are 

given as inputs and from which inverter-switching states are estimated. 

 

A ninth-order estimation algorithm is designed which provides on-line 

exponentially convergent estimates of both rotor and stator resistance for induction 

motors, when persistency of excitation conditions are satisfied and the stator currents 
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integrals are bounded, on the basis of rotor speed, stator voltages, and stator currents 

measurements. Rotor flux is also asymptotically recovered. The proposed estimation 

scheme is intended to improve performance and efficiency of currently available 

induction motor control algorithms. [4] 

 

A fuzzy logic real time estimator is used as the stator resistance observer, to 

eliminate the error in rotor resistance estimation. The performance of the induction 

motor drive with the above rotor and stator resistance estimators is investigated for 

torque and flux responses, to analyze the effects of stator resistance observer on rotor 

resistance identification, for variations in the stator and rotor resistances from their 

nominal values. Both these resistances are estimated experimentally, in a vector 

controlled induction motor drive and found to give accurate estimates. [5] 

 

A stator and rotor resistance estimation technique for the purpose of stator 

winding and rotor conductor temperature monitoring is presented in this paper. [6] 

The proposed estimation scheme is a two-step procedure based on the voltage, 

current, and speed measurements. The first step is to estimate the rotor resistance and 

rotor flux linkage simultaneously based on a Model Reference Adaptive System 

(MRAS) structure that is independent of R s . In the second step, the stator resistance 

is updated based on the estimated rotor flux linkage using the q-axis stator voltage 

equation in the synchronous reference frame. [6] 

 

A novel motor stator estimation scheme for the purpose of monitoring the 

temperature in steady state is proposed in this paper [7] and the feasibility of wavelet 

network-based estimation of the stator resistance. The occurring instants of the signal 

change can be identified by the multi-scale representation of the signal. The 

improved least squares algorithm transform is used to fulfill the network structure 

initialization and parameter identification. The corresponding temperature is 

calculated according to the principle that the metal resistance depends on its 

temperature. [7] 

 

The proposed scheme in this paper [8] is based on both a rotor resistance 

estimation technique and a lumped thermal model of an induction machine. 
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Temperature estimation based on a parameter model that determines the rotor 

resistance is quite accurate under rated load conditions. Therefore, rotor temperature 

of a slightly loaded induction machine may be better approximated by a thermal 

model which evaluates the losses of the induction machine. [8] 

 

This paper [9] studies the influence of the stator resistance variation on 

MRAS speed estimation. It has been shown that when a motor is running at high 

speed, the effect of error in stator resistance is usually quite negligible. But as the 

frequency approaches zero, this becomes more serious because the voltage drop on 

stator resistance becomes relatively larger as the frequency decreases. Under this 

reference scheme, one component of flux can be decoupled from the corrupting 

effects of the stator resistance and the other quadrature component can provide a 

near-instantaneous estimate of the stator resistance. 
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CHAPTER III 

 

 

 

METHODOLOGY 

 

 

 

 

3.1 Introduction 

 

 This chapter discusses about the methods that are used for this project. It 

includes overview of the whole system, design the estimated of induction motor 

using the equation, design Fuzzy Logic estimator, and make the correction of stator 

resistance, R s . 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.1 Flow of Stator Resistance Estimation of Induction Motor Project 

ACTUAL 
INDUCTION 

MOTOR 

 

 
 

ESTIMATED 
INDUCTION 

MOTOR 

 

FUZZY LOGIC 

ESTIMATOR 
CORRECTION 
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Figure 3.1 above shows the flow of project a stator resistance estimation of 

induction motor. There are two induction motor that needs to be designed. First is 

estimated induction motor will be design by using the equation of induction motor’s 

in MATLAB and real induction motor is designed by using Newcastle University 

Drive Simulation Library (NUDSL). Both stator resistances, R s  of induction motor 

will estimate using Fuzzy Logic estimator. Then the correction will make to the 

stator resistance of estimated induction motor. 

 

3.2 Graphical User Interface (GUI) 

 

The main reason graphical user interface (GUI) are used is because it makes 

things simple for the users. User can choose any topics above by clicking the 

subtopic, and a modeling will appear at the screen.  This GUI is created using M-File 

in MATLAB. 

 

 

Figure 3.2 GUI Topics 

Figure 3.2 consists of GUI topics which are actual induction motor, equation 

or estimated induction motor, fuzzy logic controller, and a stator resistance 

estimation of induction motor.  
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3.3 Actual Induction Motor 

 

For actual induction motor, it focuses on (NUDSL). Actual induction is 

simulated using simulink block from this library. Here, there are two conditions 

should be considered in designing induction motor, no load and on load conditions. 

 

3.3.1 Newcastle University Drives Simulation Library (NUDSL) 

 

The Newcastle University Drives Simulation Library consists of seven sub-

libraries. The seven sub-libraries are accessed from the DRIVES block which is 

located in the main simulink window. This induction motor acted as actual motor in 

the simulation. 

 

 

Figure 3.3 NUDSL Library 

 

Figure 3.3 shows (NUDSL) Version 1.0. The first six sub-libraries contain 

simulation blocks which can be used to build up and simulate various drives. All 

blocks are fully compatible with other standard SIMULINK blocks. The seventh sub-

library contains simulations built using various blocks from the other sub-libraries, 

these examples can be used to become familiar with the MATLAB simulink 

environment. 
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3.3.2 No Load  

 

  

 The no load test of an induction motor measures the rotational losses of the 

motor and provides information about it is magnetization current. The only load on 

the motor is the friction and winding losses. 

 

 

Figure 3.4 Masked No Load Actual Induction Motor 

 

Figure 3.4 shows the block diagram of actual induction motor during at no 

load. The scope can display stator current, torque value and speed of rotor. 

 

Table 3.1: Rate Data of the Simulated Induction Motor at No Load 

 

Power 4kW 
Frequency 50 Hz 

Voltage 220/380 
Current 15/8.6 A 

Rpm 1440 
Connection  Υ∆ /  

Power factor 0.8 
Stator Resistance,Rs 1.2 Ω 
Rotor Resistance,Rr 1.8 Ω 
Stator Inductance,Ls 0.156 H 
Rotor Inductance,Lr 0.156 H 

Mutual Inductance,Lm 0.143 H 
 

The value in Table 3.1 above is used as the parameter of induction motor 

during at no load. 
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Figure 3.5 Unmasked Actual Induction Motor at No Load. 

 

Figure 3.5 shows overall system of actual induction motor during at no load. 

This system started with three phase power supply is converted to DQ transform. 

Then, DQ transformation is supplied 3 phase induction motor to run the motor.  
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3.3.3 On Load 

 

 

  
Figure 3.6 Masked On Load Actual Induction Motor 

 

Figure 3.33 shows the block diagram of actual induction motor during at on 

load. The scope can display stator current, speed of rotor and torque value. 

 

Table 3.2: Rate Data of the Simulated Induction Motor at On Load 

 

Power 4kW 
Frequency 50 Hz 

Voltage 220/380 
Current 15/8.6 A 

Rpm 1440 
Connection  Υ∆ /  

Power factor 0.8 
Stator Resistance,Rs 1.2 Ω 
Rotor Resistance,Rr 1.8 Ω 
Stator Inductance,Ls 0.156 H 
Rotor Inductance,Lr 0.156 H 

Mutual Inductance,Lm 0.143 H 
Moment Inertia,J 0.024 kgm 2  

 

The value in Table 3.2 above is used as the parameter of induction motor 

during at on load. 
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Figure 3.7 Unmasked Actual Induction Motor Block with load 

 

Figure 3.7 shows overall system of actual induction motor during at on load. 

This system started with three phase power supply is converted to DQ transform. 

Then, DQ transformation is supplied 3 phase induction motor to run the motor. Here, 

the motor operates with the load. 

 

From display block, sradr /6.151=ω  

Synchronous speed, sradsync /1592.314=ω  
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Torque load 
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 Figure 3.8 Three Phase Supply 

 

Figure 3.8 shows the three phase supply has no inputs and three outputs 
which are ‘A’ Phase voltage, ‘B’ Phase voltage and 'C' Phase voltage. 

 

 
 Figure 3.9 DQ to 3PH 

 

Figure 3.9 shows the DQ to 3PH block has two inputs, D-Axis Value, Q-Axis 

Value. Three outputs are Phase 'A' Value, Phase 'B' Value, and Phase 'C' Value. 
 

 
 

Figure 3.10 DQ to Three Phase Block 
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Simple gains are use to simulate the following equations which perform the 

transform. 

A =D 

B =0.5D + 0.866025D  

 

 

 
Figure 3.11 3PH to DQ 

 

Figure 3.11 show the 3PH to DQ block has three inputs which are Phase 'A' 

Value, Phase 'B' Value, Phase 'C' value. The outputs are D-Axis Value, Q-Axis 

Value. 

 

 

 
 

Figure3.12 Three Phases to DQ Block 

 

Simple gains are use to simulate the following equations which perform the 

transform. 

 

D=0.66666A - 0.333333B - 0.33333C 

Q=0.57735B – 0.57735C 
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Figure 3.13 Voltage Fed 

 

 

Figure 3.13 explain about the Induction Motor Model block has three inputs 

which are D-Axis Stator Voltage, Q-AxisStator Voltage (stator ref. frame) and Rotor 

Speed (rads/sec). The outputs are D-Axis Stator Current (stator ref. frame), Q-Axis 

Stator Current (stator ref. frame), Electromagnetic Torque,D-Axis Rotor Current 

(stator ref. frame), and Q-Axis Rotor Current (stator ref. frame).  

 

 

 
 

Figure 3.14 Voltage Fed Induction Motor Block 

 

Consider, as a suitable starting point the following equations, which can be 

derived from the classic, twin coil DQ model of the induction motor. 
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Figure 3.15 Mechanical Dynamic 

 

Figure 3.16 shows the Mechanical Dynamics block one input, 

electromagnetic torque and one output, rotor speed (rads/sec). 

 

 

 
Figure 3.16 Unmasked Mechanical Dynamic Block 

 

J,Tld,B,H and K represent the various mechanical parameters and are user 

defined by entering their values via the block’s dialogue box. There is a direction 

sensor switch which modifies the equation when the motor is rotating backwards, 

this overcomes any need to enter negative numbers for the load parameters. This is 

due to the fact that friction forces oppose the direction of rotation, however Tld is an 

applied shaft torque independent of rotational direction. 

 

 

3.4 Estimated Induction Motor 

 

Here, estimated induction motor is designed using the equation. The equation 

got from IEEE Library. There are two equations involved which are based on stator 

voltages and stator currents and another one is stator currents and rotor speed.  
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This induction motor was designed refer to dq frame model. The choice of 

the common dqframe is usually dictated by the symmetry constraints imposed by the 

construction and excitation of the machine. 

 

 

 

 
Figure 3.17 Masked Estimated Induction Motor 

 
 

Figure 3.17 show block diagram of estimated induction motor. This induction 

is designed using mathematical model equation. 
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Figure 3.18 Unmasked Estimated Induction Motor 
 
 

Figure 3.18 shows the block diagram of overall system estimated induction 

motor. This induction motor is constructed from D-axis flux rotor, Q-axis flux rotor, 

D-axis stator current and Q-axis stator current.  
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3.4.1 D-Axis Flux Rotor Model 

 

The block showed below is for equation of D-axis flux rotor model. This 

block model designed using stator currents and rotor speed equation matrix.   

 

 
 

Figure 3.19 Unmasked D-axis flux rotor 
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Figure 3.19 shows the block diagram of D-axis flux rotor. The block diagram 

is constructed from the equation 1. 

                         
 

3.4.2 Q-Axis Flux Rotor Model 

 

The block showed below is for equation of Q-axis flux rotor model. This 

block model designed using stator currents and rotor speed equation matrix.   
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Figure 3.20 Unmasked Q-axis flux rotor 
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Figure 3.20 shows the block diagram of Q-axis flux rotor. The block diagram 

is constructed from the equation 2. 

 

3.4.3 D-Axis Stator Current 

 

 

Figure 3.21 Unmasked D-axis stator current 
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2

................. (3)
s

s im s im s s sds m m m
s dr qr ds ds s ds

r r r r r

di L L LL i v R i
dt L T L L T

s λ ωλ= + − + −
 

Figure 3.21 shows the block diagram of D-axis stator current. The block 

diagram is constructed from the equation 3. 

 

3.4.4 Q-Axis Stator Current 

 

 

Figure 3.22 Unmasked Q-axis stator current 
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Figure 3.22 shows the block diagram of Q-axis stator current. The block 

diagram is constructed from the equation 4. 

 

 

 

 

 



25 
 

3.5 Fuzzy Logic Estimator 

 

Fuzzy logic estimator designed using fuzzy logic toolbox in MATLAB. The 

Fuzzy Logic Toolbox is a collection of functions built on the MATLAB numeric 

computing environment. It provides tools to create and edit fuzzy inference systems 

within the framework of MATLAB. 

 

  

Figure 3.23 Fuzzy Inference System 

Figure 3.23 shows the step to construct fuzzy logic system. The step started 

with fis editor, membership function, rule editor, surface viewer, and rule viewer. 
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3.5.1 FIS Editor 

 

When creating a new fuzzy inference system from scratch, the place to start is 

the FIS Editor. To do that, type 

 

>> fuzzy 

 

This will call up a window that acts as the high-level view of a FIS. At the 

top of the figure, there’s a diagram that shows inputs on the left and outputs on the 

right. The system that is displayed is a default start-up system, since didn’t specify 

any particular system. The FIS Editor displays general information about a fuzzy 

inference system. There is a simple diagram at the top that shows the names of each 

input variable and each output variable. 

 

In this project, user constructs two-input, and one output system. The two inputs 

are current error (CE) )(ke , and change in current error (CCE) )(ke∆ . The one output 

is change in stator resistance sR∆ .  

To add a second input variable and change the variable names to reflect these 

designations: 

 

1. Select Edit > Add variable > Input. A second yellow box labelled input2 

appears. 

2. Click the yellow box input1. This box is highlighted with a red outline. 

3. Edit the name field from input1 to )(ke , and press enter. 

4. Click the yellow box input2. This box is highlighted with a red outline. 

5. Edit the Name field from input2 to )(ke∆ , and press enter. 

6. Click the blue box output1. 

7. Edit the name field from output1 to sR∆ , and press enter. 

8. Select File > Export > To File. 

9. Enter the File variable name fuzzy logic, and click OK. 
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The diagram is updated to reflect the new names of the input and output 

variables. There is now a new variable in the file called fuzzy logic that contains 

all the information about this system. By saving to the file with a new name, you 

also rename the entire system. The window looks like the following diagram. 

 

 

Figure 3.24 FIS Editor 

Figure 3.24 shows the fis editor of fuzzy logic inference system. Here 

Mamdani type of fuzzy is used.   

 

3.5.2 Membership Function Editor 

 
 

The Membership Function Editor is used to define the shapes of all the 

membership functions associated with each variable. Here, triangle and trapezoidal 

function are used. Next, define the membership functions associated with each of the 

variables. User can open the Membership Function Editor in one of three ways: 

 

1. Within the FIS Editor window, select Edit > Membership Functions. 

2. Within the FIS Editor window, double-click the blue icon called tip. 

3. At the command line, type mfedit. 
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When user open the Membership Function Editor to work on a fuzzy 

inference system that does not already exist in the file, there are no membership 

functions associated with the variables that user defined with the FIS Editor. The 

membership functions associated with an input or an output variable for the FIS is 

setup. A FIS variable in this region is selected by clicking it. Next the Edit pull-down 

menu, and choose Add MFs is selected. A new window appears which allows user to 

select both the membership function type and the number of membership functions 

associated with the selected variable. In the lower-right corner of the window are the 

controls that let user change the name, type, and parameters (shape), of the 

membership function, after it is selected.  

The process of specifying the membership functions for this project is as 

follows: 

1. Double-click the input variable service to open the Membership Function 

Editor. 

2. In the Membership Function Editor, enter [-0.35 0.35] in the Range and 

the Display Range fields. 

3. Create membership functions for the input variable )(ke . 

a. Select Edit > Remove All MFs to remove the default membership 

functions for the input variable service. 

b. Select Edit > Add MFs. to open the Membership Functions dialog 

box. 

c. In the Membership Functions dialog box, select trapmf and trimf as 

the MF Type. 

 

 

Figure 3.25 Trapezoidal membership function 
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Figure 3.25 shows the trapezoidal membership function. In this project, two 

membership functions used to create fuzzy logic estimator. This membership 

function used in input change current error, current error, and output, change in stator 

resistance. 

 

 

Figure 3.26 Triangular membership function 

 

Figure 3.26 shows the trapezoidal membership function. In this project, two 

membership functions used to create fuzzy logic estimator. This membership 

function used in input change current error, current error, and output, change in stator 

resistance. 

 

d. Verify that 2 for trapmf and 5 for trimf are selected as the number of 

MFs. 

e. Click OK to two curves to the input variable )(ke . 

4. Rename the membership functions for the input variable, and specify their 

parameters. 

a. Click on the curve named mf1 to select it, and specify the following 

fields in the Current Membership Function (click on MF to select) 

area: 

• In the Name field, NL. 

The Membership Function Editor: fuzzylogic window looks similar to the following 

figure.  
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Figure 3.27 Membership Function Editor for )(ke  

 

Figure 3.27 shows the membership function of current error. User can update 

the membership function by change the range of universe discorse, and move the 

membership function. 

 

b. Click on the curve named mf2 to select it, and specify the following 

fields in the Current Membership Function (click on MF to select) 

area: 

• In the name field, enter NM. Repeat this step for mf3, mf4, 

mf5, mf6, and mf7 with NS, Z, PS, PM, PL. 

5. Repeat step 1 until 4b to create variables membership function for )(ke∆

and sR∆ with different range.   

6. Enter [-0.3 0.3] and [-0.2 0.2] in the Range and the Display Range fields 

for )(ke∆ and sR∆ .  
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The window looks like the following diagram. 

 

 

Figure 3.28 Membership Function Editor for )(ke∆  
 

Figure 3.28 shows the membership function of input change current error. 

User can update the membership function by change the range of universe discorse, 

and move the membership function. 

 

 

 
Figure 3.29 Membership Function Editor for sR∆  
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Figure 3.29 shows the membership function of output change in stator 

resistance. User can update the membership function by change the range of universe 

discorse, and move the membership function. 

 

Now that the input and output variables have been named, and the 

membership functions have appropriate shapes and names, the next step is to create 

the rules of Fuzzy Logic. To call up the rule editor, View menu is gone and Edit 

rules is selected. 

 

 

3.5.3 The Rule Editor 

 
 

The Rule Editor contains a large editable text field for displaying and editing 

rules. It also has some by now familiar landmarks similar to those in the FIS Editor 

and the Membership Function Editor, including the menu bar and the status line. The 

Rule Editor is for editing the list of rules that defines the behaviour stator resistance 

estimation. The Rule Editor allows user to construct the rule statements 

automatically. Here, there are seven rules involved which are NL, NM, NS, Z, PS, 

PM, and PL.  

 

1. To insert the first rule in the Rule Editor, select the following: 

• NL under the variable CE. 

• NL under the variable CCE. 

• The and radio button, in the Connection block. 

• NL under the output variable, RC. 

 

2. Then, click Add rule. 

 

The resulting rule is  

>> If (CE is NL) and (CCE is NL) then (RC is NL) (1) 

3. Repeat the step 1 until 2 to create another rule by referring the Table 3.3 

The rules can reach until 49 of rules. 



33 
 

 

 
Figure 3.30 Rule Editor 

 

Figure 3.30 shows the rule editor of fuzzy logic estimator. 

 

Table 3.3: Rule base for the fuzzy stator resistance estimator 

 

  Current Error 

    NL NM NS Z PS PM PL 

C
ha

ng
e 

In
 C

ur
re

nt
 

E
rr

or
 

NL NL NL NL NL NM NS Z 
NM NL NL NL NM NS Z PS 
NS NL NL NM NS Z PS PM 
Z NL NM NS Z PS PM PL 
PS NM NS Z PS PM PL PL 
PM NS Z PS PM PL PL PL 
PL Z PS PM PL PL PL PL 

 

 

3.5.4 The Rule Viewer  

 

The Rule Viewer displays a roadmap of the whole fuzzy inference process. It 

is based on the fuzzy inference diagram described in the previous section. User can 

see each rule is a row of plots, and each column is a variable. The rule numbers are 

displayed on the left of each row. User can click on a rule number to view the rule in 

the status line.  
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Figure 3.31 Rule Viewer 

 

Figure 3.31 shows the rule viewer. The first two columns of plots (the six 

yellow plots) show the membership functions referenced by the antecedent, or the if-

part of each rule. The third column of plots (the three blue plots) shows the 

membership functions referenced by the consequent, or the then-part of each rule.  

 

User can shift the plots using left, right, down, and up. The menu items allow 

user to save, open, or edit a fuzzy system using any of the five basic GUI tools. The 

Rule Viewer also shows how the shape of certain membership functions influences 

the overall result. Because it plots every part of every rule, it can become unwieldy 

for particularly large systems, but, for a relatively small number of inputs and 

outputs, it performs well (depending on how much screen space devote to it) with up 

to 30 rules and as many as 6 or 7 variables. The Rule Viewer shows one calculation 

at a time and in great detail. In this sense, it presents a sort of micro view of the fuzzy 

inference system. 
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3.5.5 The Surface Viewer 

 
 
Upon opening the Surface Viewer, three-dimensional curve that represents 

the mapping from current error, change in current error and change in stator 

resistances is seen. Because this curve represents a two-input and one-output case, 

user can see the entire mapping in one plot.  

Clicking Evaluate initiates the calculation, and the plot is generated after the 

calculation is complete. To change the x-axis or y-axis grid after the surface is in 

view, change the appropriate input field, and press Enter. The surface plot is updated 

to reflect the new grid settings. 

The Surface Viewer has a special capability that is very helpful in cases with 

two (or more) inputs and one output. User can grab the axes, using the mouse and 

reposition them to get a different three-dimensional view on the data. When user 

move beyond three dimensions overall, user can start to encounter trouble displaying 

the results.  
 
 
 

 
Figure 3.32 Control surface of fuzzy stator resistance estimator 

 

Figure 3.32 tools can display how change in stator resistance as the output 

depends on two of the inputs which are current error and change in current error. 
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 CHAPTER IV 

 

 

 

RESULT & DISCUSSION 

 

 

 

 

4.1 Introduction 

 

 This chapter discusses all the results obtained from the simulation using 

MATLAB software. The discussions included no load, on load, and stator resistance 

estimation of induction motor and resistance estimation of induction motor using 

fuzzy logic.  

 

 

4.2 No Load Analysis 

 

 
Figure 4.1 Stator Current )(kI s at no load 
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 Figure 4.1 shows maximum current achieved by induction motor is 68 A at 

0.025 seconds. The induction motor needs high starting current during turned on. 

After 0.025 seconds, the current of stator is slowly decreased. At the same time, the 

current induced at rotor also slowly down. After 0.2 seconds the current is constant, 

which is 8.5 A. The current is still needed even though there is no load at induction 

motor. The magnetizing current needed to establish a magnetic field is quite large in 

an induction motor, because of the high reluctance of its air gap. Here, there is no 

load at induction motor. The only load on the motor is the friction and winding 

losses. 

 

 
Figure 4.2 Torque at no load 

 

 A figure 4.2 show maximum (pullout) torque achieves is 118 N-m. Here, the 

maximum torque occurs when the rotor is in stationary condition. At this time, the 

relative positions of the rotor and the stator field are as different as possible. 

Maximum voltage is induced into the rotor, and the larger amount of torque is 

created. At 0.05 seconds until 0.2 seconds, the value of torque is slowly decreased. 

At this time, the speed of rotor is slowly increased. When speed of rotor is increased, 

the voltage induced to rotor is decreased and the torque produced is also reduced.  At 

0.22 seconds, the torque is zero. At this moment, the synchronous speed and speed of 

rotor have reached the same speed. There is no load during this time.  
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Figure 4.3 Speed of rotor at no load 

 

 Figure 4.3 show speed of rotor is increased starting from 0 rad/s to 116 rad/s. 

At 0.2 seconds until 0.4 seconds, the speed is constant which is 157 rad/s. Here, the 

speed of rotor is constant. There is no load during the operation starting 0.2 seconds.  

 

 

4.3 On Load Analysis 

 

 

 
Figure 4.4 Stator Current )(kI s at on load 
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 Figure 4.4 explain about the maximum current achieved by induction motor 

is 68 A at 0.025 seconds. The induction motor needs high starting current during 

turned on. After that, the current of stator is slowly decreased. This happened 

because the speed of rotor is slowly increased. At the same time, the voltage induced 

also slowly down. At 0.2 until 0.4 seconds, the value of current is constant which is 

8.5 A. Here, the speed of rotor and revolution per minute of stator is almost being the 

same. Initially, the three-phase induction motor runs on no-load and after 0.41 

second, it runs on full-load. At 0.41 seconds the current start increased again which is 

11.8 A. At this moment, rotor need more induced current to pull the inertia of load. 

When the speed of rotor stabled, the induced current being constant, which is 10.5 A.  

 

 
Figure 4.5 Torque at on load 

 

Figure 4.5 show maximum (pullout) torque archived is 118 Nm. Here, the 

maximum torque occurs when the rotor is in stationary condition. At this time, the 

relative positions of the rotor and the stator field are as different as possible. 

Maximum voltage is induced into the rotor, and the larger amount of torque is 

created. At 0.05 seconds until 0.2 seconds, the value of torque is slowly decreased. 

At this time, the speed of rotor is increased. The torque produced is reduced.  At 0.22 

seconds until 0.4 seconds, the torque of induction is zero. At this moment, the 

synchronous speed and speed of rotor have reached the same speed. The slip is equal 

to zero. Initially, the three-phase induction motor runs on no-load and after 0.4 

second, it runs on full-load. At 0.4 second, the torque rise again until 30 Nm. At this 
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time, the speed of rotor is slow down, and larger amount of voltage is developed. The 

rise of torque is needed to overcome the static inertia of load.   

 

 

 
Figure 4.6 Speed of rotor at on load. 

 

 

 Figure 4.15 explain about speed of rotor is increased starting from 0 rad/s to 

116 rad/s. At 0.2 until 0.4 seconds, the speed is constant which is 157 rad/s. Here, the 

speed of rotor is constant. There is no load during the operation start 0.2 until 0.4 

seconds. Initially, the three-phase induction motor runs on no-load and after 0.4 

second, it runs on full-load causes the speed of rotor is decreased to 148.3 rad/s at 0.4 

seconds.  
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4.4 Stator Resistance Estimation Analysis 

 

 

 
Figure 4.7 Current error between actual and estimated induction motor 

 

 Figure 4.7 shows the differences between the actual stator current with 

estimated stator current of induction motor. The error between the estimated stator 

current )(kI s  and the measured stator current )(kI s  is used to determine the 

incremental value of stator resistance )( sR∆ through a fuzzy estimator.   

 

 

 
Figure 4.8 Combination of current error )(ke , and change in current error )(ke∆  
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 Figure 4.8 shows the current error )(ke and change in current error )(ke∆ . 

The green colour representative of )(ke , while blue colour representatives of )(ke∆ . 

Both these error are inputs to the fuzzy estimator. The change in current error is 

created using unit delay in MATLAB software.  

 

)1()()(
)()()()(

−−=∆
−=∆=

kekeke
kIkIkIke s

k
ss  

 

 
Figure 4.9 Stator Resistance at 1.5 

 

 Figure 4.9 show the stator resistance and estimated stator resistance of 

induction motor during 1.5 Ω.  To test the stator resistance estimation, an additional 

0.3 Ω is added in series with the induction motor stator. At 0 until 0.12 seconds, the 

value of estimated R s  is increased till 1.8 Ω. After that, the estimated R s  is dropped 

to 1.5 Ω. The stator resistance estimators can converge in a short time, as low in 50 

milliseconds. However there are some small errors between the measured and 

estimated stator resistance.  

 

The Simulations are also executed in different initial values of stator 

resistance, R s  which are 1.6 Ω and 1.7 Ω. These simulations showing the differences 

of stator resistance between estimated and actual induction motor of stator resistance. 
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Figure 4.10 Stator Resistance at 1.6Ω 

 

Figure 4.10 show the stator resistance and estimated stator resistance of 

induction motor during 1.6 Ω.  To test the stator resistance estimation, an additional 

0.4 Ω is added in series with the induction motor stator. At 0 until 0.12 seconds, the 

value of estimated R s  is increased till 1.95 Ω. After that, the estimated of R s  is 

dropped to 1.6 Ω. After that, the estimated stator resistance follow the measured of 

stator resistance.  

 

 
Figure 4.11 Stator Resistance at 1.7 Ω  

 

Figure 4.11 shows the stator resistance and estimated stator resistance of 

induction motor during 1.7 Ω.  To test the stator resistance estimation, an additional 
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0.5 Ω is added in series with the induction motor stator. At 0 until 0.12 seconds, the 

value of estimated R s  is increased till 2.1 Ω. After that, the estimated of R s  is 

dropped to 1.7 Ω. After that, the estimated stator resistance follow the measured of 

stator resistance.  
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CHAPTER V 

 

 

 

 

CONCLUSION & RECOMMENDATION 

 

 

 

 

5.1 Conclusion 

 

 

 The main objective of this project is to develop stator resistance estimation by 

using Fuzzy Logic. Fuzzy Logic acted as an observer for stator resistance to 

eliminate the error in rotor resistance estimation. 

 

 All objectives and scopes in this project have been covered and the system is 

properly running. By using MATLAB the simulation running as desired. When the 

stator currents on both induction motors are compared, the Fuzzy Logic observer will 

act as estimator to estimate the value of stator resistance produced by the induction 

motor. The increasing of stator resistance is measured and then the correction is 

made to stabilize the system.  

 

Hopefully, this project can be a platform for electrical engineer in our 

industry to solve the problem about error in rotor resistance that can leads the 

induction motor from the breakdown in worst cases. 
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5.2 Problem Encountered 

 

  

 There are few problems that had been encountered while doing this project 

such as the correction of stator resistance and rule of fuzzy logic. 

 

i) Correction of Stator Resistance 

 

Stator resistance should be corrected to stabilize the system. Here, 

closed loop transfer function must be used to improve the system 

stability. However, during closed loop transfer function is applied, the 

simulation is failed to debug. There is have clashed between the 

closed loop transfer function from adding R s  and input of R s . 

 

ii) Rule of Fuzzy Logic 

 

User need to try and error to develop the suitable rule of fuzzy logic 

according the problem faced. Fuzzy logic is a form of multi-valued 

logic derived from fuzzy set theory to deal with reasoning that is 

approximate rather than accurate. The problem in applying this is that 

the appropriate fuzzy operator may not be known. 

 

 

5.3 Future Recommendations      

 

 

 For further research, there are two recommendations to enhance and improve 

this project: 

 

i) Use Neural Network and Neurofuzzy as other methods. 

 

Neural Network and Neurofuzzy also are modern artificial intelligent 

same goes to fuzzy logic that can act as observer in estimating stator 

http://en.wikipedia.org/wiki/Multi-valued_logic
http://en.wikipedia.org/wiki/Multi-valued_logic
http://en.wikipedia.org/wiki/Fuzzy_set
http://en.wikipedia.org/wiki/Reasoning
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resistance. From the result obtained, student can compared which one 

among those methods is the best. 

 

 

ii)  Combination of Software And Hardware 

 

Combination of software and hardware can make this project more 

realistic in the real world. The software can use to control an 

induction motor by online tuning method of stator resistance, and the 

hardware is use to prove the simulation that error in rotor resistance 

depends on the stator resistance of induction motor.  
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APPENDIX A 

 

 

 

Mathematical Expressions for Estimated Induction Motor  

 
 

Stator voltage and current model equation   
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D-Axis Flux Rotor Model
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APPENDIX B 

 

 

 

M-File for Graphical User Interface (GUI) 
 
 
 

% PROJEK SARJANA MUDA 
clc,clear,close all 
mohdakmal=menu('PROJEK SARJANA MUDA',... 
        'ACTUAL INDUCTION MOTOR',... 
        'EQUATION INDUCTION MOTOR',... 
        'FUZZY LOGIC CONTROLLER',...  
        'A STATOR RESISTANCE ESTIMATION OF INDUCTION MOTOR USING 
FUZZY LOGIC',... 
        'CLOSE'); 
    mohdakmal1=num2str(mohdakmal);  
    switch mohdakmal1 
        case '1',  
            mohdakmal2=menu('ACTUAL INDUCTION MOTOR:',... 
        'ACTUAL INDUCTION MOTOR NO LOAD',... 
        'ACTUAL INDUCTION MOTOR ON LOAD',... 
        'RETURN'); 
    mohdakmal3=num2str(mohdakmal2); 
    switch mohdakmal3 
        case '1',noload; 
        case '2',hasload; 
        case '3',clc,PSM,close all 
    end 
        case '2', equationimpsm; 
        case '3', fuzzylogic;      
        case '4', aimeim; 
         case '5',clc,clear, break 
    end 
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APPENDIX C 

 

 

Block Diagram of Stator Resistance Estimation of Induction Motor 
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